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MAPPING WITH ARC VIEW

Prepare Information for Digitizing  (Plan Ahead)

1. Obtain a copy of the Betheden, MS 7.5 minute topographic quadrangle map and calculate the
decimal degree coordinates to 6 decimal places for longitude (x) and latitude (y) of the four tic
marks (used as registration points) that surround the parcel to be digitized.  For the area around
Section 16, T16N, R13E, the tics are the upper left corner of the map, the two lat/long tics on the
borders to the right and below the upper left corner, and the tic mark in Section 27.  

2. Write the x,y (long/lat) coordinates down (to 6 decimal places for longitude (x) and latitude
(y))  as registration points 1-4.  You will use these to register your map to the digitizer.

3. Decide how you want to organize the information on the map.  The computer graphic elements
that can represent geographic features are points, lines, and polygons.  

a. Points can represent building locations,
b. Lines can represent roads,  streams, or sides of a section,
c. Polygons can represent section boundaries, stand boundaries, lakes,etc.  

4. Feature labels (i.e text) will be added in the map layout window prior to printing.  Other map
items such as map title, scale bar, north arrow will be added to the map layout so don't be
concerned about putting these into the view window.

5. Hint/Warning: Always leave your map/view in decimal degrees when saving to disk. You will
change the projection from decimal degrees (i.e lat/longs) to State Plane coordinates prior to
printing, but it should not be saved to disk in any projection other than decimal degrees.

ArcView is organized by different types of windows that are used to create and examine
geographic data.  The way to view the graphic information of a map or GIS is the View window
(see the column of icons on the left side of the project window).   Tabular information about the
graphics are viewed via the Tables window and graphic layouts of printed pages are generated by
starting a Layout window.

Starting ArcView

6. Turn digitizer on prior to beginning ArcView

7. Under the Start Menu... Programs....ArcView GIS 3.2....ArcView GIS 3.2
    Be patient... it takes a while to load the application. Don’t touch/click anything!!!
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Set the View Map Projection

8. Open a new view  window; i.e touch OK when prompted to open with a new view..  

9. Answer NO to Add  Data to View. Do not request to add new data to the view.  You will do
this with the digitizer.  

10. Enlarge both windows to full view by clicking on the small square in top right hand corner of
EACH window.

11.  Pull down the Files tab menu (top line, 1st item from left), then:
a.  Extensions

1) Put Check in the Digitizer square so system will load digitizer drivers.

12. Pull down  the View tab menu (top line, 3rd item from left), then:
a. Properties 

1)  set the Map Units to decimal degrees, 
2) set the Distance Unit to feet,   

3) click on the Projection button and set the 

Category:  Projections of the World and 
Type:        Geographic.  

Follow  through with O.K.’s to end this setup procedure.

These settings and subsequent digitizer set up will insure that you can convert your map
themes to any other projection (e.g. State Plane, UTM).

b. Choose digitizer mode:

Pull down the View Tab and click on: 
Digitizer as puck mode if you will be digitizing from the digitizing tablet. 
Digitizer as mouse mode if you will be digitizing from the screen.

I.E. It toggles between puck and mouse mode; make sure the icon shows the opposite of
the mode you want. I.E. It toggles between puck and mouse mode. If a puck is shown,
then the mouse mode must have been initiated. Likewise if the mouse mode is shown
then the puck mode must have been initiated.  If you click on the mode depicted, the
mode swithches to the option you clicked on. 

If you want to digitize from the screen rather than the digitizer board, skip
the next section on “Register the Map to the Digitizer”; go to Page 4
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Register the Map to the Digitizer

The next step is to register your map to the digitizer.  This allows the software to convert from
digitizer x,y inches to the coordinate units of the theme projection (in this case, decimal degrees
of longitude (x) and latitude (y)).  

13. Tape the map to the digitizer surface with drafting tape, or fold map and place securely under
the plastic cover; do not fold more than 1 time.  

14. Under the View Tab elect  Digitizer setup to register your map.  This will open a table that
you will fill in with the control point information.   You should set an error limit between 0.01
and 0.004" (it is difficult to achieve errors smaller than 0.005").  

15. Use the top (yellow) puck button to locate each tic mark (1-4) on the quad sheet.  As you
click on each tic mark, the table fills in ID numbers 1-4.   Hint: Do the tick marks in a clockwise
manner so you will remember which one is which.

16. After you have clicked on all four tics, you can use the computer mouse to click inside the x,y
boxes in the table and type in the decimal degree coordinates for each point.  

a. West longitudes (X-coordinates)  are keyed in as negative numbers; for example  
    -89.00000 for 89.0000o West Longitude. 

b. North latitides (Y-coordinates) are positive numbers; i.e. 33.25000 for 33.250000o

North Latitude. 

17. When you have keyed in the last coordinate, the lower left part of the table will indicate a
total error and if it is less than or equal to the set error rate, you will be able to click on the
Register button.  If total error is not below the set error rate: 

a. check for errors in the coordinate values (i.e. typo error)  and/or 
b. re-digitize the locations of the registration points.  

If there is only a small difference in registration error and error set, you can adjust the error
threshold and go with the registration you have.

Save your coordinate registration values in the d:\tmp directory under a name you will
remember... Leave the extension as .txt .
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If you want to digitize from the screen, you should “Add a Theme” with the + icon and
bring in “image data” i.e. a quad sheet in the proper data and coordinate system.

Prior to digitizing, decide whether you want to digitize the features as a graphic or a theme:

Option 1: Digitize the Features as a GRAPHIC     (Continue below)

Option 2: Digitize the Features as a Theme             (Go to Page 6)

Option 1: Digitize the Features as a GRAPHIC

At this point, your digitizer is ready to input the graphic features of your map.  

18. Find the Show Symbol Window command under Window menu and use it to display the
symbols that you can change for your graphic features.  This window allows you to change point,
line and polygon styles, colors, etc.  

a. On the ??? Palette View, click on the Pencil (i.e. Line)

b. Select the first line type... solid line
    Set the size to 2.

c. On the ??? Palette View, click on the Paintbrush color palette
    Choose a Bright Red Color

This palette view is where you first select the type of graphic you will be digitizing (i.e. point,
line or polygon), then select the symbol type, color, and size  you wish to use.

19.  Next, touch the Edit button to select the graphic type, you want to digitize. 

The Edit button is the 13th button from the left on the 2nd row of symbols... the one to the
right of the big T (text) button.  Click on the button and pull the menu down to select the
straight line symbol... 2nd item below th single dot. 

 The yellow (top) button is used to select points and is also used to start a multiple-vertex line
(polyline) or polygon boundary.  The green (right button serves the same function as a double
mouse click and ends a polyline of closes a polygon.  Thus, the yellow button starts a line and
the green button ends a line.

20. Digitize the section boundary first by digitizing each side of the section as a single line
beginning outside the section; i.e. when the section lines cross at each corner a “cross” should be
formed. Later you will put a section number in each corner of the “cross”  
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The first time you begin digitizing,  use the Zoom to Extents button (looks like a little stack of
paper) to scale the boundary to your view screen.  You can zoom in or out of the view with the
little magnifier buttons (use by dragging a window).  If your view gets messed up, simply zoom
to extents.

21. Now, repeat steps 18a through 20 for each item you digitize; i.e.

a. Pick Point, Line, or Polygon   on the ??? Palette Menu

b. Choose Size 

c.  Choose Color

d. Choose Point, Line, or Polygon   on the Button Menu (Next to T)

e. Digitize object...  Yellow button begins... Blue button ends

To get the USGS symbols, on the ??? Palette menu, click on the right most symbol (palette?) 
then,  Load: J:\ esri \av_gis30 \arcview \symbols    USGS.avp file.

Editing Themes and Adding Text Annotation

Mistakes happen!  You can select any of the graphic features by use of the arrow button (lower
row on right) and click on the feature to edit.  Then you can move the graphic (by click and drag)
or delete (by the Edit / Cut graphic) commands.  Worse case, you may find you'll need to delete
and re-digitize the feature.  The symbol style can be changed by selecting the feature and using
the symbol window as described before.

The Vertex Edit button (third from left on second row) allows you to select and edit features. 
You can add, move or delete vertices of polygons or lines.

GO TO PAGE 8
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Option 2: Digitize the Features as a Theme

At this point your digitizer is ready to input the new themes of your map.

18. Under the View tab, select New Theme
a. Choose feature type as point, line, or polygon; check OK.
b. Name the shape file; such as sectionline.shp, 
    Specify the proper directory in which to store the file, and then click OK  
    (Hint: use the d:temp or d:tmp directory.)

19. Your new theme will be named in the View Screen with a check mark in the square and a
dashed line around the square... this means you are editing this particular theme.

a. To modify/change the line type, color, etc.; double click the left mouse key on the line
symbol to reveal the Legend Editor.
b. Double click on the line symbol again to reveal the Pen Palette
c. Click on the line type and then set line size on the bottom of the Pen Palette.
d. Click on the paint brush (color palette) on the upper right side of the Pen Palette and
choose the desired color.
e. Click on the APPLY button on the lower right corner of the Legend Editor; close out
the Legend Editor and the Color Palette.

20. Now your are ready to digitize the line feature you have named and specified color and size.
a. Click on the Crooked line tab (under the Window tab)
b. Your cursor becomes a + sign which means you are ready to digitize the line.
c. Put the cross-hair of the Digitizer puck over the beginning of the line to be digitized,
and press the Yellow (top) key on the puck. Yellow button begins a line. Press the
yellow key at each turn in the line/road until you reach the end of the line. If the line is a
straight line, go to the end of the line.  Press the Green button to end the line. Thus, the
yellow button begins a line and the green button ends a line. Continuous clicking of
the yellow button allows you to follow a crooked line feature.
d. Digitize all the lines that are part of the named Theme. 
e. To end the current theme, under the Theme tab, choose Stop Editing; then answer yes
to save edits on the theme to the proper directory. 

For each additional theme, start at Step 18 and repeat the process. 
a. Under View choose New theme; choose theme type, name it and choose directory.
b. Edit the symbol for style, size, and color.
c. Digitize the feature.
d. Under Theme, Stop Editing and yes to store edits. 

21.  To Edit a theme,
a. Make the theme active by clicking on the theme name...box shows around name.
b. Under Theme tab, choose Start Editing; now you edit all features within the theme.
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c. Don’t forget that you can click on the vertex edit key (hollow arrow, third from left)
    and then move/add the vertices of a line. 
d. When done editing, under the Theme tab, choose Stop Editing.
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Put All Text/Annotations on View Screen

Add all text and annotations relating to the digitized image/object(s) on the View screen so that if
you change to a new projection, everything stays in the proper location.   The map title, graphic
scale bar, equivilent scale, north arrow, etc. will be added on the Layout screen.  As soon as all
text/annotations are added for the digitized objects, save the project to disk so that it will be in
decimal degrees.

Layouts and Printing

One very handy feature of ArcView is that once you have coded information in decimal degrees,
you can re-project the data to some other system such as State Plane or Universal Transverse
Mercator (UTM) coordinates.  This is done by changing the views projection under View /
Properties.  For printing, you will need to change to a projection that accurately depicts your
map in true cartesian perspective.  To do this, you should change the view projection from
Geographic to another projection such as State Plane (NAD 83). 

22. In the Project window, select the Layout Icon and click on the New button to start a new
page layout.  You will see a new window open with the graphic equivalent of the printed page
depicted.  Use the Layout / Properties menu selection to change setting such as snap to grid. 
Graphic elements can be added in the same way they were added to views.

The layout window must be active to activate the layout button menu system.  

23. To get the map graphics from your View to theLlayout, click on the tiny globe symbol... 2nd

symbol to right of big T symbol on 2nd row. Once you have clicked on the tiny globe, create box
on the Layout area by clicking and holding the left mouse key and dragging the area boundary to
create a rectangular region on your layout page.  

24. You will be prompted to supply the View name.  Pick the view that you want to insert into
the layout box, then before you click O.K.:

Set the scale to User Specified (in this case 1" = 20 chains or 1:15840).  
Now click O.K. and the view is put into the Layout Box.

CAUTION/WARNING: Once the view is inserted into the Layout Box, you can move it around
by putting your mouse pointer in the center of the edit box , but DO NOT use the corner or side
edit marks to change the size.... The scale was set when you specified it previously.... If you
change size now, the scale is changed.

25. You can add a graphic scale in the same fashion. Click the globe item (drag region) that
shows a scale bar.
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26. A north arrow can be added in similar fashion to the scale bar (drag region) then select the
arrow style you want.

27. To add text (for the title, equivalent scale, etc.), select the text "T" button, click where you
want to insert it, then type the text you want in the layout and click OK.

Pull the ??? Palette View down from the Windows Tab and click on the A,B,C, (i.e. text
button). Now you can set the size, color, font of text before you place it (i.e. touch the T
button)  and during the editing of text.

Parts of a Complete Map

Your map should/must contain:

* Complete Title - what, where, how, who, when
* Map body with proper cartographic symbols
* North Arrow
* Graphic scale bar with stated RF and equivalent scale.
* A wide outside border and narrower line approximately 0.5 inches inside of outside
border. 
Hint: Use the regtangular polygon with a width of 3 or 4 for the outside border and the
same with a width of 1 or 2 for the inside border.

Print Layout/Map
 
Once the layout is complete, you can send it the the printer by selecting File / Print on the
project window. If you digitized in decimal degrees (i.e. lat/longs) then change the View
projection to State Plane -83 then Mississippi- East so that the G.L.O. section will not be
“squashed”. DO NOT save in State Plane, save prior to re-projecting then print.

Saving Work

If you think you will want to come back to your map at some future time, you should save your
work as a project file.  With Views and Layouts closed, you can select File / Save Project from
the project menu and save your work to disk.  Check with the instructor on where you are
allowed to save your files and/or use a virus-checked floppy disk.

Instructions prepared by Dr. Robert C. Parker and Dr. David L. Evans    May 31, 2000
Modified by Dr. Robert C. Parker in Summer and Fall, 2002.


